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Using the Internet in the Classroom 

 

What is the Internet? 

The Internet is the actual network of servers, routers, and computers that are linked 
worldwide. The Internet holds all of the information that makes up the World Wide 
Web, email, FTP (File Transfer Protocol), Gopher, Telnet, etc. 

You may have heard the terms “dot com” or “dot net”. These are file name 
extensions that indicate the domain, and the “dot” is a period. Examples include: 

 .com = commercial .edu = education org = organization  

 .net = network provider .gov = government .mil = military  
 

Are the terms Internet and World Wide Web the same? 

Although the terms are used interchangeably, they are different. The Internet is the 
actual network of wires, computers, servers, routers, etc. The World Wide Web is a 
facet of the Internet. In other words, it is where the WWW is stored. The reason that 
everyone uses the terms interchangeably is that the World Wide Web is the 
Internet’s most common facet. 

 

What can I do on the Internet? 

The Internet is very powerful. You can use the Internet to: 

• Communicate through email, listservs, bulletin boards, and teleconferencing 

• Browse through pages on the World Wide Web 

• Search, using search engines and/or Web guides 

• Find resource information, pictures, etc., to supplement and enrich your lessons 

• Find lesson plans, not only those that use traditional teaching methods and 
materials, but also others that integrate the use of technology 

• Integrate using the Internet into classroom lessons 

• Participate in on-line projects 

• Design WebQuests and other projects for students  

• Create Web pages to put your class or school on the Web 

• Create Web pages to put your own educational tools on the Web 

• Open your classroom to the world! 



 

Blount County Schools Technology 10/10/01 Using the Internet in the Classroom p. 2 

World Wide Web Terminology 

Internet – A lot of computers hooked together through telephone lines, network 
cables, satellite dishes, and many other types of data communication links. 

World Wide Web (WWW)  – Officially described as a “wide-area hypermedia 
information retrieval initiative aiming to give universal access to a large universe of 
documents via hypertext links”. WWW pages (sites) may include text, graphics, and 
hypertext links to other Web pages. Web browsers enable users to explore the 
World Wide Web. 

Web Browsers – The name given to software programs that allow you access and 
explore the World Wide Web. Netscape and Internet Explorer are examples of 
browser software. 

Web Page – A page in a Web site that may contain text, graphics, still and moving 
images, sounds, and links to other Web pages on the World Wide Web. 

Home Page – The Web document that appears at the start of a session. This can 
be set to your personal choice by going to a site you want to use. Click on Edit on 
the menu bar, then click Preferences. Click the Use Current Page button, and 
your home page is set. It can be changed at any time. 

Bookmarks – Called bookmarks by Netscape and favorites by Internet Explorer, 
they provide a way to create a shortcut to favorite Web sites. 

HTML – Stands for HyperText Mark-up Language. This is the programming code 
that creates documents accessible by a Web browser. 

Hyperlink – A way to link a Web page to another Web page, graphic, or sound. 
Hyperlinks are usually underlined or are a different color than the text or images 
around them. 

Hypermedia –Hypertext with a difference – hypermedia documents contain links 
not only to other pieces of text, but also to other forms of media, like sounds, 
images, and movies. Images themselves can be selected to link to sounds or 
document. Hypermedia simply combines hypertext and multimedia. 

HyperText –Basically the same as regular text; it can be stored, read, searched, or 
edited, with an important exception; hypertext contains connections, or links, to other 
documents within the text. These links may connect to other parts of the same Web 
page, other Web pages on the same machine or to another Web page anywhere in 
the world.  

URL – Stands for Uniform Resource Locator. It is an address pointer to hypermedia 
documents available on the Web. Note:  Every Web page has a unique URL. URL’s 
are case sensitive.  

URL Anatomy:  http://www.blountk12.org/teacherlinks/index.html 

 
Hypertext 
Transfer 

Server 
Name 

Filename 
 

Directory 
Or Folder 
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Browsing the Web Using Netscape Navigator 

Netscape Navigator is the browser part of Netscape. The page that appears 
automatically is the home page. The directions for setting a home page are in the 
Email Preference section page 2. You can always return to the home page by 

clicking the Home button on the tool bar of the Netscape window. 

 

You can move to a new page if you know its URL—the location or address—on the 
Web. Click in the Location box. This will select the address of your home page. 
Type in the Web address of the page you want to view. You do not have to type the 
“http://” prefix at the beginning of the address. Most addresses start with “www”. 
Web page addresses are very sensitive, both to case, spaces, and punctuation 
marks. For example, a comma instead of a period (dot) will cause an error 
message. After typing the address, press the Enter key. 

You can type part of a URL, such as "apple" (for www.apple.com), or type a general 
word, such as "gifts" or "flowers." Navigator guesses what page you want to view, 
or displays a page with a choice of links related to the typed word. 

As you move the mouse over a page, the pointer will sometimes change to a 
pointing finger. This happens when the pointer is over a link. When a link is clicked, 
you will be taken to another Web page, or another part of the same Web page. You 
can recognize word links because they are usually a different color (standard is blue 
for nonvisited links, and purple for a link that has been visited). Graphics can also 
be links and are sometimes harder to recognize. Watch for the hand! 

To return to a previous page, click the Back button. You can also use the Forward 
button to move back and forth between pages you have visited.  

Sometimes a page will open in a new Netscape window that appears on top of the 
first window. Then the Back button will not be active. You may wonder what 
happened to your other page, but if you look at the task bar at the bottom of your 
screen, you will see that you have two Netscape windows open. You can toggle 
back and forth by clicking the Netscape buttons on the task bar, or just close the 
window on top by clicking the “x” box in the upper right-hand corner. 

There are several Web sites with tutorials and information on learning to use the 
Internet. On the Teacher Links page, click Teaching with Technology and look 
under Using the Internet. 
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Adding Bookmarks 

Once you have gone to the trouble of searching and finding great sites, you may 
want to bookmark them. Then you will be able to easily find them without going 
through the search process again or having to remember a long address, or url.  

1. Find a Web site you want to bookmark. 

2. Click Bookmark button on the left side of the tool bar. 

3. Click Add Bookmark. 

Note: If you keep adding bookmarks in this manner, you will end up with a very long 
list of sites. It is a good idea to set up folders to keep bookmarks organized. 

To go to a bookmarked site: 

1. Click the Bookmark button. 

2. Click the folder where the bookmarked site is filed. 

3. Click the name of the site. 

Creating Folders 

1. Click the Bookmark button on the toolbar. 

2. Click Edit Bookmarks. The Bookmarks window will open. 

3. Click File →→  New Folder on the menu bar. Type a folder name and click OK. 

4. Repeat until you have enough folders. 

Adding Bookmarks to Folders  

1. Find a Web site you want to bookmark. 

2. Click Bookmark button. 

3. Click File Bookmark. 

4. Click the folder where you want to put the site. 

5. Check the name of the bookmark and edit if necessary. 

Editing Bookmarks 

1. Click the Bookmark button. 

2. Click Edit Bookmarks. 

The Bookmarks window will open. From this location, you can rename the 
bookmark so that you will better remember it. Just click on the bookmark you want 
to rename. Under Edit on the menu bar, click Bookmark Properties. Type the new 
name in the Name box. Then click OK. You can delete sites (right-click or click the 
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Delete button on the keyboard) and drag-and-drop bookmarked sites to other 
folders in the Edit Bookmarks window as well. 
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Saving and Using Stuff from the Internet 

Printing from the Web 

Print any Web page by clicking the Print button on the tool bar. You may waste a lot 
of ink and/or paper, however, and also get more pages than you want or need. To 
preview the number of pages that will print, as well as what will be on each page: 

• Click File → Print Preview.  

• Click the Next Page button at the top to view more than one page. You may 
realize that you only need page 1, or page 2, etc.  

To print: 

• Click the Print button at the top left.  

• If you do not need all the pages, you can print just the pages you need. In the 
Print range section (lower left of Print window) click Pages instead of All.  

• Click in the from: box and type the first page you want to print. Then click in the 
to: box and type the last page you want to print. If you only want one page, type 
the page number in both boxes.  

• Click the OK button to print. 

• Click the Close button when finished. 

Copying Text from a Web Page 

Sometimes, however, you just need the text, or only part of the text, from a Web 
page. When you save text for a report or project, first make a note of the location of 
the page by copying the address (URL) in the "Address" or "Location" bar at the top 
of your browser. You will need this information when to cite a Web sources in a 
bibliography. (Click in the location box to hi-light the Web address, then click Copy 
under Edit. Open MS Word, and under Edit click Paste.) 

1. Select the text you want to save by clicking and dragging across the entire block 
of text. If you have difficulty, try starting at the upper left-hand corner and dragging 
the mouse to the lower right.  

2. Release the mouse button and the text should be selected or darkened. 

3. Pull down the Edit menu and click Copy. 

4. Open a new Microsoft Word document. 

5. Pull down the Edit menu and click Paste. You should now see all of your text in 
the word processor. The formatting will probably look funny, and you can clean it 
up if necessary. Then print. 

6. To save the information, give the document a name it and save to a folder. 
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Saving Images from the Web 

Pictures and graphics can be saved to use in a document, 
a Web page, or any multimedia project.  

• Right-click on a picture or graphic 

• Click Save Image As... on the pop-up menu 

• Click the down-arrow at the end of the Save in box 

• Choose a location to keep your saved “stuff” 

Tip:  Click on Desktop, click the Create New Folder 
icon, type a name for the folder—like Graphics, click on the 
new folder, then click the Open button 

 

• Click in the File name box and, if necessary, give the graphic a user-friendly 
name 

• Click the Save button 

Now you can use the saved picture or graphic in a word processing document or 
multimedia project.  
 

Copyright Issues 

Fair Use provisions allow you to use the sites you harvest in your classroom alone. 
NEVER place any material you harvest from the Web BACK onto the Web via your 
school or personal Web site. Be sure that ALL material is only accessible in-house. 
Be sure to obtain permission from site creators if you'd like to use ANY of their 
material (graphics especially) on a Web site that the whole world can see. When in 
doubt, ask for permission for any and all content that you harvest. Be sure to follow 
copyright laws for copyrighted materials.  

Good information about educational copyright laws can be found at:   

http://lcweb.loc.gov/copyright/circs/circ21.pdf 

More information can be found on the Teacher Link page, Teaching with 
Technology. 
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Downloading from the Web 

One of the most common questions is “What happened to it?” when downloading 
from the Web. If given a choice of what to save the file, always save to your 
Desktop.  

• Click the down-arrow at the end of the Save in box and click Desktop 

 

• Click in the File name box and, if necessary, give the file a user-friendly name 

• Click the Save button 

Many downloads are programs. What you download is actually a setup file. Once 
the file is downloaded, it must be installed.  

• Close Netscape and all other programs (you usually have to restart) 

• Double-click the setup icon and click the buttons to install the program. 

• Once the program is installed, the setup file can be deleted. 

What if you are not given a choice of where to save a file? 

First, pay attention to the dialog box while the file is downloading. It should show the 
name of the file, and the directory may also be listed at the top of this box, such as 
C: /MyDownloadFiles or C:/Windows/Temp 

Places to look for downloaded files: 

• My Download Files folder on the C: drive 

• Downloaded Program Files folder in the Windows folder (I.E.) 

• Temp folder in the Windows folder 

• My Documents folder on the Desktop 

• Last resort, click Start�Find�Files or Folders; type the file name and click the 
Find Now button 

Adobe Acrobat Reader 

This is a very useful program to download to any computer.. It allows the computer to 
open .pdf files, a popular way of posting documents on the Web. It is found at 
http://www.adobe.com/products/acrobat/readstep.html  
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A link to this site can be found in several places on the BCS Web site.
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Searching 

Search engines allow you to use keywords to find what you need on the Web. When 
performing a search with any engine, you must first enter your topic. Most search 
engines overlap the same information and use similar formats, but you should find 
one that you are comfortable with. Search engines do not, contrary to popular belief, 
find everything on the Internet.  

Trial and error (and therefore patience) is necessary when using a search engine. 
You may have to change or completely redo your search if the results are not what 
you expect. 

Important Tip: Phrase searching is often the most effective type of search. When 
you want to search for a phase, it is important to enclose the phrase in quotations 
(Ex. “Educational testing”). Otherwise, you will get results that include only one of the 
phrase words. 

 

Choosing the BEST Search Engine 

There are numerous search engines and Web guides on the Internet that can help 
you find just the right information. Some engines and guides specialize in certain 
types of information, while others allow you to specify options for your search. Listed 
below are some of the different types.  

Web Search Utilities – People who create Web pages submit them to a Web 
service, where key words from the pages are put into a database. A search for one 
of the key words of a page will yield a link to that page. Examples:  Alta Vista, 
Excite, HotBot, Infoseek Ultra, and WebCrawler. 

Web Meta Search Utilities – send the search you create to several of the Web 
search utilities at once, thereby sparing you the effort of searching one after the 
other manually. Examples:  Dogpile, MetaCrawler, and Savvy Search. 

Web Directories – each site, or Web page, registered with a directory is placed 
within a hierarchy according to its topic. The total number of sites represented tends 
to be smaller than those of the Web search utilities. Examples:  LookSmart and 
Yahoo. 

Internet Resource Directories – lists of non-Web, but still Internet based 
resources. Examples:  Listserv Directory, Usenet Directory, and Email Addresses.  

 

Links to all of these search engines, along with tips for searching, by accessing a 
great Web site called Findspot  

http://www.findspot.com 

A link to Findspot can be found on the Teacher Links page (click on the 
binoculars). 
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More Advanced Searches 

It's really hard to choose a search engine. They are not topically oriented and they 
all index everything that comes their way. That's one of the reasons the meta search 
utilities are growing in popularity. 

The "+" symbol works exactly the same as the word and, allowing you to search for 
a combination of words in a single search. However, even though you think you are 
narrowing your search by typing Prince + Charles, the search may very well result in 
directing you to the artist formerly known as Prince, or Prince Tennis racquets, or 
perhaps Charles Manson. Again, the Findspot site offers some good search tips 
for each search engine. 

Some search engines are more sophisticated than others, allowing you to define 
your search more accurately, thereby ensuring more precise results. Listed below 
are some good advanced search engines. 

Lycos Advanced Search:  lycospro.lycos.com/  (Lycos also has parental 
controls) 

Excite Advanced Search:  www.excite.com/search_forms/advanced 

Yahoo Advanced Search:  search.yahoo.com/search/options 

Snap.com Power Search:   

home.snap.com/search/power/form/0,179,home-0,00.html?st.sn.srch.0.pwr 

 

There are some good Web Search engines for students that filter inappropriate 
Web sites. None of them are fool-proof, however, so students should always be 
monitored when out in cyberspace. Some of these include:  

Yahooligans www.yahooligans.com/ 

KidsClick sunsite.Berkeley.edu/KidsClick!/  

Searchopolis www.searchopolis.com/ 

NoodleQuest www.noodletools.com/noodlequest/main.php3 

All of these sites can be found on the Teaching with Technology Teacher Links 
Web page, and also the Student Links Web page. 
 

Evaluating Web Sites 

Just because something is on the Internet does not mean it has value. Anyone can 
put absolutely anything out on the Web. It is important for you, and your students as 
well, to evaluate a Web site for content, validity, and ease of use. Helps and hints for 
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evaluating Web sites can be found on the Teaching with Technology Teacher 
Links Web page. 
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Creating Web-based Lessons and Activities 

There are many different types of Web-based activities already created that can be 
found on the Web. The Teaching with Technology Teacher Links Web page is a 
good place to start looking for these activities, as well as for help in creating your 
own. Kinds of activities include scavenger or treasure hunts, virtual field trips, Web 
quests, and online projects. 

Participating in Internet-based Collaborative Projects 

Participating in online projects is a great way to use the Internet in the classroom. 
Most projects involve doing some kind of activities in your classroom, and then 
emailing the results to a project coordinator. The final results for all participants will 
usually be posted on the Web for participating classes to observe. This is a 
wonderful way to really “open your classroom to the world”. As projects come to our 
attention, we will post them on the listserv. 

The Classroom Connect listserv offers teachers a way to post projects so that 
other classes can participate. It also sends information from other teachers about 
good Web sites, Internet projects, etc. Subscribe through the Classroom 
Connect’s Web site: www.connectedteacher.com/listServ/subscribe.asp 

TrackStar 

TrackStar is a wonderful Web resource that allows teachers to create Web-based 
lessons that can be accessed by students on the Web. It is an online interface that 
helps teachers organize on-line resources (URL’s) and file them in the TrackStar 
database. Directions can be added that tell students what to look for or accomplish 
when visiting each link in the track. The list of resources, acting like a table of 
contents to the Track, remains visible throughout the lesson, allowing the 
user/student to easily browse through the lesson and stay on track. An online quiz 
can be created to evaluate progress. Find out more at:  

http://scrtec.org/track/ 

WebQuests 

WebQuest lessons are teacher-designed, skill and proficiency-specific, task-
oriented units of instruction. The lessons provide a relatively safe, teacher-directed 
environment in which students may access the Web. WebQuests can be short or 
long term, and usually have an introduction, a task, information resources, a 
process, learning guidance and advice, evaluation, and a conclusion 

For more information on WebQuests, see the WebQuest Page, and other Web 
quest sites found on the Teaching with Technology Teacher Links Web page. 
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A Little History and a Few Facts about the Internet 

• The Internet began as the ARPANET (Advanced Research Projects Agency). 

• ARPANET was designed for scientific and military needs in the 1960’s. 

• In the mid-1990’s, the NSF (National Science Foundation) funded six 
supercomputers for scientific research located in cities across the United 
States. 

• In 1986, the NSF expanded by funding its NSFNET. Remote access came 
about via high-speed phone lines. At this point, it was known for text only. 

• In the early 1990’s, the World Wide Web was created, which changed the way 
people used the Internet. 

• The WWW was born near Geneva, Switzerland at the European Laboratory for 
Particle Physics, as a way to share research information. 

• This was the beginning of hypertext, or linked, documents. The transition from 
government to business use was underway 

• Senator Al Gore laid the groundwork for the next phase of the Internet through 
the High Performance Computing Act. He desired to link schools, 
universities, government agencies, and anyone else to a faster network. He 
envisioned the NREN (National Research and Education Network). 

 


